Informatica PowerExchange for Salesforce
(Version 9.6.0)

User Guide
Table of Contents

Preface ................................................................. iii
Informatica Resources. ........................................ iii
  Informatica My Support Portal. ................................ iii
  Informatica Documentation. ..................................... iii
  Informatica Web Site. .......................................... iii
  Informatica How-To Library. ................................... iv
  Informatica Knowledge Base. ................................... iv
  Informatica Support YouTube Channel. ....................... iv
  Informatica Marketplace. ......................................... iv
  Informatica Velocity. ............................................ iv
  Informatica Global Customer Support. ......................... iv

Chapter 1: Introduction to PowerExchange for Salesforce. .......... 1
  PowerExchange for Salesforce Overview. ........................ 1

Chapter 2: PowerExchange for Salesforce Configuration. .......... 2
  Prerequisites. .................................................. 2
  Configuring HTTP Proxy Options at Design-Time. ............... 2
    Configuring HTTP Proxy Options from the Developer Tool. .... 2
  Configuring HTTP Proxy Options at Run-Time. ................... 3

Chapter 3: Salesforce Connections. ................................ 5
  Salesforce Connection Overview. ............................... 5
  Salesforce Connection Properties. ............................... 5
  infracmd Connection Properties. ................................ 6
  Creating a Salesforce Connection in the Developer Tool. ....... 7
  Creating a Salesforce Connection in the Administrator Tool. . 8

Chapter 4: Salesforce Data Objects. ................................ 9
  Salesforce Data Objects Overview. ............................ 9
  Standard and Custom Salesforce Objects. ......................... 9
  Related Objects. ................................................ 10
    Understanding Related Objects. ................................ 10
    Rules and Guidelines for Related Objects. .................... 10
  Salesforce Data Object Views. .................................. 10
  Salesforce Data Object Overview Properties. ..................... 10
  Salesforce Data Object Read Operation Properties. ............. 11
    Source Properties of the Data Object Read Operation. ....... 11
    Output Properties of the Data Object Read Operation. ....... 12
  Importing a Salesforce Data Object. ............................ 16
# Table of Contents

Creating a Salesforce Data Object Read Operation. ........................................... 16

**Chapter 5: Salesforce Mappings.** ................................................................. 17
Salesforce Mappings Overview. ......................................................................... 17
Salesforce Mapping Example. ........................................................................... 17

**Chapter 6: Salesforce Lookup.** ................................................................. 19
Salesforce Lookup Overview. ........................................................................... 19
Salesforce Lookup Condition. ........................................................................... 19
Salesforce Lookup Properties. ........................................................................... 20
  - General Properties. ..................................................................................... 20
  - Ports Properties. ......................................................................................... 21
  - Columns Properties. .................................................................................... 21
  - Lookup Properties. ..................................................................................... 21
  - Advanced Properties. .................................................................................. 22
Multiple Matches. ............................................................................................ 22
Rules and Guidelines for Salesforce Lookup. .................................................. 23
Adding a Salesforce Data Object Operation as a Salesforce Lookup in a Mapping. ......................................................................................... 24

**Chapter 7: Salesforce Run-time Processing.** ........................................... 25
Salesforce Run-time Processing Overview. ................................................... 25
Filtering Source Data by Using the SOQL Filter Condition. ......................... 25
Filtering Source Data by Using the Informatica Filter Condition. ................. 26
Capture Deleted and Archived Salesforce Records. ....................................... 26
Capturing Changed Data. ................................................................................ 26
  - Continuous CDC Mapping. ....................................................................... 27
  - Configure a Continuous CDC .................................................................... 27
  - Time-Period Based CDC Mapping. ............................................................. 27
  - Configure a Time-Period Based CDC ......................................................... 28
  - Rules and Guidelines for Processing a Time-Period Based CDC Mapping. ............................................................... 28
Configure Bulk API .......................................................................................... 28
Sorted Ports. ..................................................................................................... 28
CustomSOQL Query. ......................................................................................... 29

**Appendix A: Datatype Reference.** .............................................................. 30
Datatype Reference Overview. .......................................................................... 30
Salesforce Datatypes and Transformation Datatypes. .................................... 30

Index. .............................................................................................................. 32
Preface

The PowerExchange for Salesforce User Guide provides information to import metadata from Salesforce objects, build mappings and and extract data from Salesforce objects. It is written for the developers who are responsible for extracting data from Salesforce objects.

This book assumes you have knowledge of web services concepts, relational database concepts, Informatica, and Salesforce. You must also be familiar with the interface requirements for other supporting applications.

Informatica Resources

Informatica My Support Portal


The site contains product information, user group information, newsletters, access to the Informatica customer support case management system (ATLAS), the Informatica How-To Library, the Informatica Knowledge Base, Informatica Product Documentation, and access to the Informatica user community.

Informatica Documentation

The Informatica Documentation team takes every effort to create accurate, usable documentation. If you have questions, comments, or ideas about this documentation, contact the Informatica Documentation team through email at infa_documentation@informatica.com. We will use your feedback to improve our documentation. Let us know if we can contact you regarding your comments.

The Documentation team updates documentation as needed. To get the latest documentation for your product, navigate to Product Documentation from http://mysupport.informatica.com.

Informatica Web Site

You can access the Informatica corporate web site at http://www.informatica.com. The site contains information about Informatica, its background, upcoming events, and sales offices. You will also find product and partner information. The services area of the site includes important information about technical support, training and education, and implementation services.
Informatica How-To Library

As an Informatica customer, you can access the Informatica How-To Library at http://mysupport.informa.com. The How-To Library is a collection of resources to help you learn more about Informatica products and features. It includes articles and interactive demonstrations that provide solutions to common problems, compare features and behaviors, and guide you through performing specific real-world tasks.

Informatica Knowledge Base

As an Informatica customer, you can access the Informatica Knowledge Base at http://mysupport.informa.com. Use the Knowledge Base to search for documented solutions to known technical issues about Informatica products. You can also find answers to frequently asked questions, technical white papers, and technical tips. If you have questions, comments, or ideas about the Knowledge Base, contact the Informatica Knowledge Base team through email at KB.Feedback@informatica.com.

Informatica Support YouTube Channel

You can access the Informatica Support YouTube channel at http://www.youtube.com/user/INFASupport. The Informatica Support YouTube channel includes videos about solutions that guide you through performing specific tasks. If you have questions, comments, or ideas about the Informatica Support YouTube channel, contact the Support YouTube team through email at supportvideos@informatica.com or send a tweet to @INFASupport.

Informatica Marketplace

The Informatica Marketplace is a forum where developers and partners can share solutions that augment, extend, or enhance data integration implementations. By leveraging any of the hundreds of solutions available on the Marketplace, you can improve your productivity and speed up time to implementation on your projects. You can access Informatica Marketplace at http://www.informaticamarketplace.com.

Informatica Velocity

You can access Informatica Velocity at http://mysupport.informa.com. Developed from the real-world experience of hundreds of data management projects, Informatica Velocity represents the collective knowledge of our consultants who have worked with organizations around the world to plan, develop, deploy, and maintain successful data management solutions. If you have questions, comments, or ideas about Informatica Velocity, contact Informatica Professional Services at ips@informatica.com.

Informatica Global Customer Support

You can contact a Customer Support Center by telephone or through the Online Support.

Online Support requires a user name and password. You can request a user name and password at http://mysupport.informa.com.

Chapter 1

Introduction to PowerExchange for Salesforce

This chapter includes the following topic:

- PowerExchange for Salesforce Overview

PowerExchange for Salesforce Overview

You can integrate PowerExchange for Salesforce with Salesforce to extract data from Salesforce sources. Salesforce sources represent objects in the Salesforce object model. Salesforce objects are tables that correspond to tabs and other user interface elements on the Salesforce web site. For example, the Account object contains the information that appears in fields on the Salesforce Account tab.

PowerExchange for Salesforce uses the Salesforce security model to enforce data access controls. You can access data based on the Salesforce organization, or org, associated with the user login you use to connect to Salesforce. Your access to data also depends on the user privileges and the field and row level permissions associated with the login.

PowerExchange for Salesforce uses the SOAP API to read a small volume of data in near real-time mode. PowerExchange for Salesforce can read large amounts of data from Salesforce sources using the Salesforce Bulk API. PowerExchange for Salesforce generates an SOQL query to read data from Salesforce objects. The SOQL language is a derivative of SQL. You can override the SOQL query and use the CustomSOQL query to read data from Salesforce objects based on custom queries. You can use PowerExchange for Salesforce to capture changed data from a Salesforce object.

You can run a profile on a Salesforce data object. A Salesforce data object profile discovers information about the column data and metadata in the Salesforce data source.

Example

Your organization needs to migrate real-time sales opportunity information from a Salesforce system that the sales team uses to a relational data source that the executive management team uses. You can create a data object in the Model repository and import the Opportunity object. Use change data capture to capture real-time opportunity details at fixed time intervals. The executive management team can reconcile and analyze the data written to the relational data object.
Prerequisites

Before you use PowerExchange for Salesforce, install and configure Informatica services and clients.

Create a Data Integration Service and Model Repository Service.

Configuring HTTP Proxy Options at Design-Time

If your organization uses a proxy server to access the internet, you can configure the HTTP proxy server authentication settings at design-time. You can configure the HTTP proxy server authentication from the developerCore.ini file.

Configuring HTTP Proxy Options from the Developer Tool

If your organization uses a proxy server to access the internet, you can configure the HTTP proxy server authentication settings from the developerCore.ini file.

- Ensure that you enable the proxy server settings from your web browser.
- Access the developerCore.ini file from the following location:
  
  <Informatica Installation Location>\clients\Developer Client\bin
Add the following properties to the developerCore.ini file:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-Dhttp.proxyHost=</td>
<td>Name of the HTTP proxy server.</td>
</tr>
<tr>
<td>-Dhttp.proxyPort=</td>
<td>Port number of the HTTP proxy server.</td>
</tr>
<tr>
<td>-Dhttp.proxyUser=</td>
<td>Authenticated user name for the HTTP proxy server. This is required if the proxy server requires authentication.</td>
</tr>
<tr>
<td>-Dhttp.proxyPassword=</td>
<td>Password for the authenticated user. This is required if the proxy server requires authentication. <strong>Note:</strong> The password is in plain text and not encrypted.</td>
</tr>
<tr>
<td>-Dhttp.nonProxyHosts=</td>
<td>List of host names or IP addresses for which you must not use the proxy server. Separate the list of IP addresses or host names with a pipe symbol (</td>
</tr>
<tr>
<td>-Dhttps.proxyHost=</td>
<td>Name of the HTTPS proxy server.</td>
</tr>
<tr>
<td>-Dhttps.proxyPort=</td>
<td>Port number of the HTTPS proxy server.</td>
</tr>
</tbody>
</table>

Configuring HTTP Proxy Options at Run-Time

If your organization uses a proxy server to access the internet, you must configure the HTTP proxy server authentication settings for the Data Integration Service.

1. Open the Administrator tool.
2. Click the Administration tab, and then select the Data Integration Service.
3. Click the Properties tab.
4. Click Edit in the HTTP Proxy Server Properties section.
5. Configure the following properties:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HTTP Proxy Server Host</td>
<td>Name of the HTTP proxy server.</td>
</tr>
<tr>
<td>HTTP Proxy Server Port</td>
<td>Port number of the HTTP proxy server. Default is 8080.</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>HTTP Proxy Server User</td>
<td>Authenticated user name for the HTTP proxy server. This is required if the proxy server requires authentication.</td>
</tr>
<tr>
<td>HTTP Proxy Server Password</td>
<td>Password for the authenticated user. This is required if the proxy server requires authentication.</td>
</tr>
<tr>
<td>HTTP Proxy Server Domain</td>
<td>Domain for authentication.</td>
</tr>
</tbody>
</table>
CHAPTER 3

Salesforce Connections

This chapter includes the following topics:

- Salesforce Connection Overview, 5
- Salesforce Connection Properties, 5
- infacmd Connection Properties, 6
- Creating a Salesforce Connection in the Developer Tool, 7
- Creating a Salesforce Connection in the Administrator Tool, 8

Salesforce Connection Overview

Use a Salesforce connection to access objects in a Salesforce application.

Create a connection to import Salesforce metadata to create data objects, preview data, and run mappings.

You can create a Salesforce connection in the Developer tool, the Administrator tool, and through infacmd isp.

Salesforce Connection Properties

Use a Salesforce connection to connect to a Salesforce object.

The following table describes the Salesforce connection properties:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the connection. The name is not case sensitive and must be unique within the domain. It cannot exceed 128 characters, contain spaces, or contain the following special characters: ~`!#$%^&amp;*()_+-={}[]</td>
</tr>
<tr>
<td>ID</td>
<td>String that the Data Integration Service uses to identify the connection. The ID is not case sensitive. It must be 255 characters or less and must be unique in the domain. You cannot change this property after you create the connection. Default value is the connection name.</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Description</td>
<td>The description of the connection. The description cannot exceed 765 characters.</td>
</tr>
<tr>
<td>Location</td>
<td>The Informatica domain where you want to create the connection.</td>
</tr>
<tr>
<td>Type</td>
<td>The connection type. Select Salesforce.</td>
</tr>
<tr>
<td>User Name</td>
<td>Salesforce user name.</td>
</tr>
<tr>
<td>User Password</td>
<td>Password for the Salesforce user name. To access Salesforce outside your organization's trusted networks, you must append a security token to your password to log in to the API or a desktop client. To receive or reset your security token, log in to Salesforce and click Setup</td>
</tr>
<tr>
<td>Service URL</td>
<td>URL of the Salesforce service you want to access. In a test or development environment, you might want to access the Salesforce Sandbox testing environment. For more information about the Salesforce Sandbox, see the Salesforce documentation.</td>
</tr>
</tbody>
</table>

### infacmd Connection Properties

You can create a Salesforce connection with the create connection commands. You can update a Salesforce connection with the update connection commands.

Enter connection options in the following format:

... -o option_name=value option_name=value ...

For example,

```
infacmd createConnection -dn DomainName -un Domain_UserName -pd Domain_Pwd -cn conname -cid conname -ct SFDC -o userName=salesforceUserName password=salesforcePWD serviceURL=https://login.salesforce.com/services/Soap/u/26.0
```

To enter multiple options, separate them with a space. To enter a value that contains a space or other non-alphanumeric character, enclose the value in quotation marks.
The following table describes Salesforce connection options for infacmd isp CreateConnection and UpdateConnection commands:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>userName</td>
<td>Salesforce user name.</td>
</tr>
<tr>
<td>password</td>
<td>Password for the Salesforce user name. The password is case sensitive. To access Salesforce outside your organization's trusted networks, you must append a security token to your password to log in to the API or a desktop client. To receive or reset your security token, log in to Salesforce and click Setup</td>
</tr>
<tr>
<td>serviceURL</td>
<td>URL of the Salesforce service that you want to access. In a test or development environment, you might want to access the Salesforce Sandbox testing environment. For more information about the Salesforce Sandbox, see the Salesforce documentation.</td>
</tr>
</tbody>
</table>

Creating a Salesforce Connection in the Developer Tool

Create a connection before you import Salesforce data objects, preview data, or run mappings. When you create a Salesforce connection, you enter information such as a connection ID and the URL of the Salesforce service you want to access.

1. Click **Window > Preferences**.
2. Select **Informatica > Connections**.
3. Expand the domain.
4. Select **Enterprise Applications > Salesforce** and click **Add**.
5. Enter a connection name.
6. Enter an ID for the connection.
7. Optionally, enter a connection description.
8. Select the domain where you want to create the connection.
9. Select **Salesforce** as the connection type.
10. Click **Next**.
11. Configure the connection properties.
12. Click **Test Connection** to verify that you can connect to the Salesforce system.
13. Click **Finish**.
Creating a Salesforce Connection in the Administrator Tool

Create a connection before you import Salesforce data objects, preview data, or run mappings. When you create a Salesforce connection, you enter information such as a connection ID and the URL of the Salesforce service you want to access.

1. In the Administrator tool, click the Domain tab.
2. Click the Connections view.
3. In the Navigator, select the domain.
4. In the Navigator, click Actions > New > Connection.
   The New Connection dialog box appears.
5. In the New Connection dialog box, select Salesforce, and then click OK.
   The New Connection wizard appears.
6. Enter a connection name.
7. Enter an ID for the connection.
8. Optionally, enter a connection description.
9. Enter the connection properties
10. Click Test Connection to verify that you can connect to the Salesforce system.
11. Click Finish.
CHAPTER 4

Salesforce Data Objects

This chapter includes the following topics:

- Salesforce Data Objects Overview, 9
- Standard and Custom Salesforce Objects, 9
- Related Objects, 10
- Salesforce Data Object Views, 10
- Salesforce Data Object Overview Properties, 10
- Salesforce Data Object Read Operation Properties, 11
- Importing a Salesforce Data Object, 16
- Creating a Salesforce Data Object Read Operation, 16

Salesforce Data Objects Overview

A Salesforce data object is a physical data object that uses a Salesforce object as a source. A Salesforce data object is the representation of data that is based on a Salesforce object.

Import a Salesforce object into the Developer tool to create a Salesforce data object. After you create a data object, create a data object read operation. You can use the data object read operation as a source in a mapping.

Standard and Custom Salesforce Objects

Use the Developer tool to import Salesforce objects and create a Salesforce data object. You can import both standard and custom Salesforce objects.

Standard object types are objects packaged within Salesforce, such as Account, AccountPartner, and Opportunity.

Custom object types extend the Salesforce data for an organization by defining data entities that are unique to the organization. Salesforce administrators can define custom fields for both standard and custom objects.

When you import a Salesforce object, use a Salesforce login to connect to the Salesforce service. The Developer tool generates a list of objects that are available for import.
Related Objects

You might need to read data from more than one object at a time. The Data Integration Service generates relationship queries through SOQL to read data from related objects.

For example, you can read all accounts created by Tom Smith and the contacts associated with those accounts. PowerExchange for Salesforce allows parent-to-child relationships that connect the objects.

Understanding Related Objects

Parent-to-child relationships exist between many types of objects. For example, Account is a parent of Contact, Assets, and Cases.

Use PowerExchange for Salesforce to read related objects. Each object can have multiple related objects. You can create a data object called Account Details. Select Account as the parent object and Contact and Opportunity as the child objects. The relationship persists while creating a Salesforce data object read operation from the Salesforce data object called Account Details.

Rules and Guidelines for Related Objects

Use the following rules and guidelines when you import related objects in a Salesforce data object:

- You must select a parent object to create a data object that has related objects.
- You cannot import multiple parent objects in a single data object.
- You can select multiple related objects for each parent object.
- You cannot read data from a related object while using Bulk API and changed data capture. You can read data from one parent object.

Salesforce Data Object Views

The Salesforce data object contains views to edit the object name and the properties.

After you create a Salesforce data object, you can change the data object properties in the following data object views:

- **Overview** view. Edit the Salesforce data object name, description, and object.
- **Data Object Operation** view. View and edit the properties that the Data Integration Service uses when it reads data from a Salesforce data object.

When you create a mapping that uses a Salesforce source, you can view the data object read properties in the **Properties** view.

Salesforce Data Object Overview Properties

The **Overview** view displays general information about the Salesforce data object and detailed information about the Salesforce object that you imported.
The following table describes the general properties that you configure for a Salesforce data object:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the Salesforce data object.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the Salesforce data object.</td>
</tr>
<tr>
<td>Connection</td>
<td>Name of the Salesforce connection.</td>
</tr>
</tbody>
</table>

The following table describes the Salesforce object properties that you can view:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the Salesforce object.</td>
</tr>
<tr>
<td>Type</td>
<td>Native datatype of the Salesforce object.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the Salesforce object.</td>
</tr>
</tbody>
</table>

**Salesforce Data Object Read Operation Properties**

The Data Integration Service reads data from a Salesforce object based on the data object read operation. The Developer tool displays the data object read operation properties of the Salesforce data object in the **Data Object Operation** view.

You can view or configure the data object read operation from the source and output properties.

- **Source properties.** Represents data that the Data Integration Service reads from the Salesforce object. Select the source properties to view data such as the name and description of the Salesforce object and the column properties.
- **Output properties.** Represents data that the Data Integration Service passes into the mapping pipeline. Select the output properties to edit the port properties of the data object read operation. You can also set advanced properties, such as changed data capture, row limit, and Salesforce bulk API.

**Source Properties of the Data Object Read Operation**

The source properties are populated based on the Salesforce object that you added when you created a data object. The source properties of the data object read operation include general and column properties that apply to the Salesforce object.

You can view the source properties of the data object read operation from the **General**, **Column**, and **Advanced** tabs.

**General Properties**

The general properties display the name and description of the data object object read operation.
Column Properties

The column properties display the datatypes, precision, and scale of the source property in the data object read operation.

The following table describes the source column properties of the data object read operation:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the column.</td>
</tr>
<tr>
<td>Type</td>
<td>Native datatype of the column.</td>
</tr>
<tr>
<td>Precision</td>
<td>Maximum number of significant digits for numeric datatypes, or maximum number of characters for string datatypes. For numeric datatypes, precision includes scale.</td>
</tr>
<tr>
<td>Scale</td>
<td>Maximum number of digits after the decimal point for numeric values.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the column.</td>
</tr>
<tr>
<td>sForceName</td>
<td>Field name in Salesforce.</td>
</tr>
<tr>
<td>referenceTo</td>
<td>Gets referenced object.</td>
</tr>
<tr>
<td>isCreatable</td>
<td>Indicates whether the field allows inserts.</td>
</tr>
<tr>
<td>isUpdateable</td>
<td>Indicates whether the field allows updates.</td>
</tr>
<tr>
<td>isExternalID</td>
<td>Salesforce custom fields only. Indicates whether the field is designated as an external ID field. Each Salesforce object can contain a single custom field designated as the external ID field. Salesforce appends custom field names with &quot;_c&quot;. For more information about external ID and custom fields, see the Salesforce documentation.</td>
</tr>
<tr>
<td>isIDLookup</td>
<td>Specifies a record in an upsert call. The ID field of each object and some Name fields have this property. There are exceptions, so check for this property in any object you want to upsert.</td>
</tr>
</tbody>
</table>

Advanced Properties

The advanced property displays the physical name of the Salesforce object.

Output Properties of the Data Object Read Operation

The output properties represent data that the Data Integration Service passes into the mapping pipeline. Select the output properties to edit the port properties of the data object read operation.

The output properties of the data object read operation include general properties that apply to the data object operation. The output properties also include port, source, query, and advanced properties that apply to the Salesforce object.

You can view and change the output properties of the data object read operation from the General, Ports, Sources, Query, and Advanced tabs.
General Properties
The general properties display the name and description of the data object read operation.

Ports Properties
The output ports properties display the datatypes, precision, and scale of the data object read operation.
The following table describes the output ports properties that you configure in the data object read operation:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the port.</td>
</tr>
<tr>
<td>Type</td>
<td>Datatype of the port.</td>
</tr>
<tr>
<td>Precision</td>
<td>Maximum number of significant digits for numeric datatypes, or maximum number of characters for string datatypes. For numeric datatypes, precision includes scale.</td>
</tr>
<tr>
<td>Scale</td>
<td>Maximum number of digits after the decimal point for numeric values.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the port.</td>
</tr>
</tbody>
</table>

Sources Properties
The sources properties list the Salesforce objects in the data object read operation.

Query Properties
Use the query property to select specific records from Salesforce by using the filter.
The filter expression uses the Informatica platform expression to select specific records.

Filter Expression Properties
You can select specific records from Salesforce based on the filter condition you specify.
The following table describes the properties you specify when you filter records from Salesforce:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| Expression Type | The type of filter expression that you can use to filter records.  
|              | Default is Platform Expression.                                              |
| Left Field  | The Salesforce object on which you want to apply the filter condition.       |
Simple operators you can use to filter records.
You can select one of the following operators:
=, !=, <, <=, >, >=

The value you specify to filter Salesforce objects.
For a string datatype and a NULL expression, you must not enclose the values in quotes (') and (").

Creating a Filter

You can specify a filter expression to search for a subset of the original data source that meets the filter criteria.

Specify a filter expression from the output properties of the Salesforce data object read operation.

1. In the Object Explorer view, open a Salesforce data object read operation.
2. From the Properties view, select the Query tab.
The Filter view appears.
3. Click Edit.
The Filter Expression editor appears.
4. Click Add. Enter the filter expression properties and click OK.

Advanced Properties

Use the advanced properties to specify data object read operation properties to read data from Salesforce objects.

The following table describes the advanced properties that you configure in the data object read operation:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SOQL Filter Condition</td>
<td>Filters Salesforce source records.</td>
</tr>
<tr>
<td>CDC Start Timestamp</td>
<td>Start date and time for the time period. The Data Integration Service extracts data that was added or modified after this time. Must be in the format YYYY-MM-DDTHH:MI:SS.SSSZ. Enter 00 for second and millisecond values because Salesforce API ignores second and millisecond values. Configure for continuous and time-period based changed data capture.</td>
</tr>
<tr>
<td>CDC End Timestamp</td>
<td>End date and time for the time period. The Data Integration Service extracts data that was added or modified before this time. Must be in the format YYYY-MM-DDTHH:MI:SS.SSSZ. Enter 00 for second and millisecond values because Salesforce API ignores second and millisecond values. Configure for time-period based changed data capture.</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Custom SOQL                  | Issues a special SELECT statement for the Data Integration Service to read source data. The custom query replaces the default query that the Data Integration Service uses to read data from sources.  
You can also specify a file path that contains a custom query. There can be only one query in the file. For example,  
\%<MachineName>\shared\customsql.txt  
**Note:** If the value of the custom SOQL starts with SELECT, then the Data Integration Service assumes that it is a custom SOQL query. |
| Use QueryAll                 | Runs a query that returns all rows, which includes active, archived, and deleted rows. Otherwise, the Data Integration Service returns active rows.                  |
| Row Limit                    | Specifies the maximum number of rows the Data Integration Service processes. Default is 0, which indicates that the Data Integration Services processes all records.        |
| Sorted Ports                 | Retrieves data from a field in a specific order. For example, you want the data for the following fields to appear in a particular order, such as name, address, and contact number. Separate the fields with a comma. For example,  
name, address, contact number  
If the data for the first field is identical, the Salesforce API will sort the data by the second field.  
The maximum length is 256 characters. |
| Page Size                    | Maximum number of records the Data Integration Service can read from a Salesforce source in one batch. Default is 200 records.  
Not used in Bulk API sessions.                                                                                                                                               |
| Use SFDC Bulk API            | Uses the Salesforce Bulk API to read batch files containing large amounts of data from Salesforce sources. By default, the Data Integration Service uses the standard Salesforce API. |
| CDC Time Limit               | The number of minutes for which that the Data Integration Service reads changed Salesforce data. When you set the CDC Time Limit to a non-zero value, the Data Integration Service reads the records and then captures changes to the Salesforce data for the time period you specify. Set the value to -1 to capture changed data for an infinite period of time.  
**Note:** Configure CDC Time Limit and CDC Flush Interval for continuous changed data capture. |
| CDC Flush Interval           | The interval in minutes at which the Data Integration Service captures changed Salesforce data. If you set the CDC Time Limit to a non-zero value, the Data Integration Service captures changed data from the source at the specified time interval. Otherwise, the Data Integration Service ignores this property. Default is 5.  
**Note:** Configure CDC Time Limit and CDC Flush Interval for continuous changed data capture. |
Importing a Salesforce Data Object

Import a Salesforce data object to read data from a Salesforce object.

1. Select a project or folder in the Object Explorer view.
2. Click File > New > Data Object.
3. Select Salesforce Data Object and click Next.
   The New Salesforce Data Object dialog box appears.
4. Enter a name for the data object.
5. Click Browse next to the Location option and select the target project or folder.
6. Click Browse next to the Connection option and select the Salesforce connection from which you want to import the Salesforce object.
7. To add an object, click Add next to the Selected Resource(s) option.
   The Add Resource dialog box appears.
8. Select a Salesforce object. You can search for it or navigate to it.
   • Navigate to the Salesforce object that you want to import and click OK.
   • To search for the Salesforce object, enter the name of the Salesforce object you want to add. Click OK.
9. If required, add additional objects to the Salesforce data object.
   You can also add objects to a Salesforce data object after you create it.
10. Click Finish.
    The data object appears under Physical Data Objects in the project or folder in the Object Explorer view.

Creating a Salesforce Data Object Read Operation

You can add a Salesforce data object read operation to a mapping or mapplet as a source. You can create the data object read operation for one or more Salesforce data objects.

Before you create a Salesforce data object read operation, you must create at least one Salesforce data object.

1. Select the data object in the Object Explorer view.
2. Right-click and select New > Data Object Operation.
   The Data Object Operation dialog box appears.
3. Enter a name for the data object read operation.
4. Select Read as the type of data object read operation.
5. Click Add.
   The Select Resources dialog box appears.
6. Select the Salesforce object for which you want to create the data object read operation and click OK.
7. Click Finish
   The Developer tool creates the data object read operation for the selected data object.
CHAPTER 5

Salesforce Mappings

This chapter includes the following topics:

- Salesforce Mappings Overview, 17
- Salesforce Mapping Example, 17

Salesforce Mappings Overview

After you create a Salesforce data object read operation, you can develop a mapping. You can define the following objects in the mapping:

- Salesforce data object read operation as the input to read data from Salesforce metadata.
- Relational, flat file, or any supported data object as the output.

Validate and run the mapping to extract the Salesforce data and load it to a relational or flat file target.

Salesforce Mapping Example

Your organization, ABC Corporation, needs to migrate real-time sales opportunity information from a Salesforce system that is used by the sales team to a relational data source that is used internally by the executive sales management team.

Create a mapping that reads opportunity in real-time and writes those records to a table.

You can use the following objects in a Salesforce mapping:

Mapping Input

The mapping source is a Salesforce data object that contains the Opportunity object. Add the Opportunity object to the physical data object.

Create a data object read operation and set the time limit and flush interval for change data capture in the data object read operation. Add the data object read operation to the mapping.

CDC Time Limit=300
Flush interval=60

Mapping Output

Add a relational data object to the mapping as an output.
After you run the mapping, the Data Integration Service writes the extracted opportunity information to the target table. Sales managers can use the information to track sales opportunities.
Salesforce Lookup Overview

You can use a Salesforce data object read operation to look up data in a Salesforce object. You add a Salesforce data object read operation to a mapping as a Salesforce lookup. You can look up data from Salesforce in a mapping based on a lookup condition.

For example, you can look up the billing details of the Account object for specific cities when you add the Salesforce data object read operation as a lookup in a mapping.

You can look up data in a Salesforce object from any standard or custom Salesforce object available to your Salesforce user account. The Data Integration Service queries the lookup source based on the ports that you specify in the Salesforce lookup. It generates queries in Salesforce Object Query Language (SOQL), a derivative of SQL. It generates a query for each row that enters the Salesforce lookup. The Data Integration Service compares the lookup port values to lookup source field values based on the SOQL queries.

A Salesforce lookup is a dynamic filter for every row of data that comes into the mapping. You can apply a lookup based on a condition from Salesforce. The filter condition based on the source is a WHERE clause for the Salesforce data object read operation.

Salesforce Lookup Condition

The Data Integration Service extracts data from the lookup source based on the condition that you configure.

The lookup condition is a WHERE clause in an SQL query. When you configure a lookup condition in a Salesforce lookup, you compare the value of one or more columns in the source data with values in the lookup source.
Consider the following points when you enter a condition for a Salesforce lookup:

- You can use string, integer, or decimal datatypes.
- The datatypes must be the same between source port and lookup ports.
- The precision and scale must be of the same precision range between the source port and lookup port.

For example, you configure a Salesforce lookup based on the Salesforce object named Account. The connected lookup input port is City. The connected lookup output ports are ID, Name, and BillingCity. You configure the following lookup condition:

\[ \text{City} = \text{BillingCity} \]

For each billing city, the Data Integration Service returns the ID, Name, and BillingCity column from the lookup source.

You can also use the SOQL filter conditions in the Advanced properties and an Informatica filter condition in the Query property of a Salesforce data object read operation.

### Salesforce Lookup Properties

The Salesforce lookup properties represent data that the Data Integration uses to look up records in Salesforce. Select the Salesforce lookup properties to edit the port properties of the Salesforce lookup.

The Salesforce lookup properties include general properties that apply to the data object operation. They also include port, column, lookup, and advanced properties that apply to the Salesforce lookup. You can view and change the lookup properties of the data object read operation from the **General**, **Ports**, **Columns**, **Lookup**, and **Advanced** tab.

#### General Properties

The general properties display the name and description of the Salesforce lookup. You can configure the lookup policy for multiple matches.

The following table describes the general properties that you can view and edit for a Salesforce lookup:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the Salesforce lookup.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the Salesforce lookup.</td>
</tr>
<tr>
<td>Physical Data Object</td>
<td>Name of the Salesforce data object read operation.</td>
</tr>
<tr>
<td>On multiple matches</td>
<td>Determines which row the Salesforce Lookup returns when it finds multiple rows that match the lookup condition. You can choose one of the following options:</td>
</tr>
<tr>
<td></td>
<td>- Return first row</td>
</tr>
<tr>
<td></td>
<td>- Return last row</td>
</tr>
<tr>
<td></td>
<td>- Return any row</td>
</tr>
<tr>
<td></td>
<td>- Return all rows</td>
</tr>
<tr>
<td></td>
<td>- Report error</td>
</tr>
</tbody>
</table>
Ports Properties

The ports properties display the input ports from the source in the mapping to the Salesforce lookup. You can specify the ports to be available as output ports from the Salesforce lookup. The ports properties display the datatypes, precision, and scale of the source port.

The following table describes the ports properties:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the source port.</td>
</tr>
<tr>
<td>Type</td>
<td>Datatype of the source port.</td>
</tr>
<tr>
<td>Precision</td>
<td>Maximum number of significant digits for numeric datatypes, or maximum number of characters for string datatypes. For numeric datatypes, precision includes scale.</td>
</tr>
<tr>
<td>Scale</td>
<td>Maximum number of digits after the decimal point of numeric values.</td>
</tr>
<tr>
<td>Output</td>
<td>Specify the ports that must be available as output ports from the Salesforce lookup.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the port.</td>
</tr>
</tbody>
</table>

Columns Properties

The columns properties are based on the Salesforce lookup object. The columns properties display the datatypes, precision, and scale of the Salesforce object that you are looking up.

The following table describes the columns properties of the Salesforce lookup:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the column.</td>
</tr>
<tr>
<td>Type</td>
<td>Native datatype of the column.</td>
</tr>
<tr>
<td>Precision</td>
<td>Maximum number of significant digits for numeric datatypes, or maximum number of characters for string datatypes. For numeric datatypes, precision includes scale.</td>
</tr>
<tr>
<td>Scale</td>
<td>Maximum number of digits after the decimal point of numeric values.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the column.</td>
</tr>
</tbody>
</table>

Lookup Properties

You can specify the properties to look up a Salesforce object.
The following table describes the lookup properties that you can specify for a Salesforce lookup:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lookup Column</td>
<td>The name of the columns that you want to look up.</td>
</tr>
</tbody>
</table>
| Operator     | Operators that you can use to filter records. You can select one of the following operators: 
                             = != < <= > >= |
| Source Port  | The input source port.                                                     |

**Advanced Properties**

The advanced properties display the properties that you have set for the Salesforce data object read operation.

You can also view and edit the tracing level. You can set the amount of detail that the Data Integration Service writes to the log.

**Multiple Matches**

The Data Integration Service can return more than one row from the lookup source. You can configure which row the Data Integration Service returns when it finds multiple rows that match the lookup condition.

You can choose one of the following options:

- **Return first row**
  Salesforce lookup generates a `LIMIT 1` clause in the query that limits the result set to 1. To retrieve the first row based on a specific order of the field, such as by ID, you must specify the ordering criteria and configure the underlying read operation to sort ports by ID.

- **Return last row**
  Salesforce lookup generates a `LIMIT 1` clause in the query that limits the result set to 1. To retrieve the last record based on a specific order of the field, such as by ID, you must specify the ordering criteria and configure the underlying read operation to sort ports by ID.

- **Return any row**
  Salesforce lookup generates a `LIMIT 1` clause in the query that limits the result set to 1. The Data Integration Service ignores any order that you specify to sort ports in the underlying read operation.

- **Return all rows**
  Returns all matching rows. You can specify a specific order to sort ports in the in the underlying read operation.

- **Report error**
  If more than one record matches the Salesforce lookup condition, the mapping fails.
Example

You want to look up employees with salaries that are more than $40,000. Enter the following Salesforce lookup condition:

$$\text{SALARY} > 40000$$

To specify an order, configure the read operation to sort ports by salary.

**Note:** If you do not specify an order, the results are unpredictable.

The following employee information is available:

<table>
<thead>
<tr>
<th>Employee</th>
<th>Salary</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paul</td>
<td>45000</td>
</tr>
<tr>
<td>David</td>
<td>30000</td>
</tr>
<tr>
<td>Susan</td>
<td>45000</td>
</tr>
<tr>
<td>Melissa</td>
<td>50000</td>
</tr>
<tr>
<td>Michael</td>
<td>60000</td>
</tr>
<tr>
<td>Tim</td>
<td>35000</td>
</tr>
</tbody>
</table>

The Data Integration returns rows based on your selection for multiple matches.

The following table displays the options for multiple matches and the corresponding return values:

<table>
<thead>
<tr>
<th>Multiple Matches Options</th>
<th>Return Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Return first row</td>
<td>Paul 45000</td>
</tr>
<tr>
<td>Return last row</td>
<td>Michael 60000</td>
</tr>
<tr>
<td>Return any row</td>
<td>Returns the first value that matches the lookup condition. The Data Integration Service might or might not return the first row. <strong>Note:</strong> The Data Integration ignores the order you set to sort ports in the underlying read operation.</td>
</tr>
<tr>
<td>Return all rows</td>
<td>- Paul 45000</td>
</tr>
<tr>
<td></td>
<td>- Susan 45000</td>
</tr>
<tr>
<td></td>
<td>- Melissa 50000</td>
</tr>
<tr>
<td></td>
<td>- Michael 60000</td>
</tr>
</tbody>
</table>

Rules and Guidelines for Salesforce Lookup

Consider the following rules and guidelines when you enter a condition for a Salesforce lookup:

- You cannot use a Salesforce data object read operation that you configure for bulk, change data capture, or custom SOQL.
• If you use related objects, you can only look up a parent object.
• Verify your Salesforce user account settings to determine the rate limits when you look up a Salesforce object.

Adding a Salesforce Data Object Operation as a Salesforce Lookup in a Mapping

Use a Salesforce lookup to look up data in a flat file, reference table, or relational data object.

1. Open a mapping from the Object Explorer view.
2. From the Object Explorer view, drag a Salesforce data object read operation to the editor.
   The Add to Mapping dialog box appears.
3. Select Lookup to add the data object read operation as a lookup in the mapping.
4. Click inside the Salesforce data object operation and connect the lookup input ports and the lookup output ports.
5. Select the Lookup tab from the Properties view.
6. Enter the lookup condition properties.
7. When the mapping is valid, click File > Save to save the mapping to the Model repository.
Salesforce Run-time Processing

This chapter includes the following topics:

- Salesforce Run-time Processing Overview, 25
- Filtering Source Data by Using the SOQL Filter Condition, 25
- Filtering Source Data by Using the Informatica Filter Condition, 26
- Capture Deleted and Archived Salesforce Records, 26
- Capturing Changed Data, 26
- Configure Bulk API, 28
- Sorted Ports, 28
- CustomSOQL Query, 29

Salesforce Run-time Processing Overview

When you develop a Salesforce mapping, you define data object operation read properties that determine how data is read from Salesforce sources.

The data object read operation properties you can set include properties for changed data capture, bulk API, and row limit.

Filtering Source Data by Using the SOQL Filter Condition

The Data Integration Service generates an SOQL query based on the objects and fields included in the Salesforce source. When you configure a mapping that reads data from a Salesforce source, you can enter a filter condition to filter records read from the source. When you enter a filter condition, the Data Integration Service adds the WHERE clause to the SOQL query.

To filter records from a Salesforce source, set the SOQL filter condition in the data object read operation. For example, enter the following filter condition to read records from the Salesforce Account object that were created before October 30, 2012:

```
CreatedDate < '2012-10-30T00:00:00.000Z'
```

Enter a filter condition based on the SOQL syntax in the Salesforce documentation. The Salesforce API performs SOQL syntax validation at run time. If you enter a filter condition that is not valid, the mapping fails.
Filtering Source Data by Using the Informatica Filter Condition

When you specify a source filter, the Developer tool adds a WHERE clause to the default query. The Informatica filter condition uses the AND operator to combine multiple filter conditions specified through the Filter Expression editor.

To filter records from a Salesforce object by using the Informatica filter expression, specify the conditions in the Filter Expression editor of a data object read operation. You can access the Filter Expression editor from the Query tab of a Salesforce data object read operation.

For example, if you want to filter records for the Account object where the billing state is California, specify the following filter condition in the Filter Expression editor:

\[
\text{Account.BillingState} = \text{CA}
\]

If you have also set the SOQL filter condition in the Advanced properties, the filter query is appended to the filter expression specified in the Filter Expression editor and is passed on to Salesforce.

For example, you have set the filter condition in the Filter Expression editor to filter records for the Account object where the billing state is California. You have also set the SOQL filter condition in the Advanced properties to read records from the Salesforce Account object that were created before October 30, 2012, the two filter conditions are appended and passed on to Salesforce:

\[
\text{BillingState} = \text{CA} \text{ AND } \text{CreatedTime} < \text{value}
\]

Use the following guidelines when you use the filter condition:

- You can filter records that have decimal, integer, and string datatypes.
- For related objects, you can use the filter expression only for the parent object. If you use the filter expression for a child object, unexpected results might occur.

Capture Deleted and Archived Salesforce Records

The Data Integration Service can capture active, deleted, and archived records from a Salesforce object. By default, mappings do not capture deleted and archived records.

To capture deleted and archived records, configure the Use queryAll data object read operation property.

Capturing Changed Data

The Data Integration Service can capture changed data from a Salesforce object that is replicateable and contains CreatedDate and SysModstamp fields.

If you configure a data object operation to capture changed data from a Salesforce object that is not replicateable or does not contain CreatedDate and LastModified fields, the mapping fails. For more information about replicateable objects, see the Salesforce documentation.

Use one of the following methods to capture changed data:

- Capture changed data continuously. Configure a mapping to capture changed data in real-time.
• Capture changed data for a specific time period. Configure a mapping to capture changed data during a particular time period when the data changes.

By default, change data capture is disabled. To enable a particular method, specify the required attributes in the data object operation read properties. Configure the attributes for one CDC method. If you configure properties for both methods, the Data Integration Service captures changed data continuously.

If the record is inserted and updated during the same CDC interval, then PowerExchange for Salesforce reads two records with two row types, such as insert and update. Use the row type to determine update strategy.

By default, the SystemModstamp is the time stamp that determines when a Salesforce record was last modified.

Continuous CDC Mapping

When the Data Integration Service runs a mapping configured for continuous CDC, it reads records that were created, modified, or deleted in the specified time and passes them to the next transformation as rows flagged for insert, update, or delete. The Data Integration Service reads records from the Salesforce server time or at the CDC Start time specified in the data object read operation.

The Data Integration Service completes the following tasks to capture changed data for a continuous CDC session:

• Reads all records created and passes them to the next transformation as rows flagged for insert.
• Reads all records updated and passes them to the next transformation as rows flagged for update.
• Reads all records deleted and passes them to the next transformation as rows flagged for delete.

After the Data Integration Service finishes reading all changed data, the flush interval starts again. The Data Integration Service stops reading from Salesforce when the CDC time limit ends.

For example, you set the CDC time limit to 60 minutes and the flush interval to five minutes. After the Data Integration Service reads the data, the flush interval begins. The Data Integration Service captures changed data after each five minute flush interval. The Data Integration Service stops reading from Salesforce after 60 minutes.

Configure a Continuous CDC

Complete the following tasks to capture changed data continuously for mappings that read from replicatable Salesforce objects:

Set the following properties in the data object read operation for continuous change data capture.

• CDC Time Limit and CDC Flush Interval, or
• CDC Start Timestamp and CDC Time Limit with CDC Flush Interval

Note: The Data Integration Service reads the records from the CDC Start Timestamp specified till the Salesforce server time. After the records are read, continuous CDC starts based on the CDC Time Limit and CDC Flush Interval specified.

Time-Period Based CDC Mapping

When the Data Integration Service runs a CDC mapping for a specific time period, it reads all records in the data object and extracts records that meet the CDC time period criteria.
The Data Integration Service completes the following steps to capture changed data for a time-period based CDC session:

- Reads all records created between the CDC start time and end time, and passes them to the next transformation as rows flagged for insert.
- Reads all records updated between the CDC start time and end time, and passes them to the next transformation as rows flagged for update.
- Reads all records deleted between the CDC start time and end time, and passes them to the next transformation as rows flagged for delete.

Configure a Time-Period Based CDC

To enable change data capture for a specific time period, define the CDC Start Timestamp and CDC End Timestamp for the time period in the data object operation read properties.

Rules and Guidelines for Processing a Time-Period Based CDC Mapping

Use the following rules and guidelines when you run a mapping with CDC for a particular time period:

- The Data Integration Service validates the formats of the start and end times when you run the mapping. If either timestamp format is wrong, the mapping fails.
- The values for the start and end times must be in the past.
- The start time must predate the end time.
- You cannot run the mapping continuously.

Configure Bulk API

The Data Integration Service can read data from Salesforce sources using the Salesforce Bulk API. Use the Bulk API to read large amounts of data from Salesforce while generating a minimal number of API calls.

With the Bulk API, each batch of data can contain up to approximately 1 GB of data in CSV format. When the Data Integration Service creates a batch, it adds any required characters to properly format the data, such as adding quotation marks around text.

You can also monitor the progress of batches in the log file.

To configure a mapping to use the Salesforce Bulk API, select the Use SFDC Bulk API data object operation read property.

Sorted Ports

The Data Integration Service can sort data based on selected ports in the data object read operation. When you specify an order, the Data Integration Service adds an ORDER BY clause to the SOQL query.
CustomSOQL Query

The Data Integration Service can read data based on custom queries you enter in the data object read operation. The CustomSOQL query overrides the relationship specified in the data object read operation.

Example

- You can enter queries for aggregates in a data object read operation. For example,

  `select max(AnnualRevenue) maxRevenue from Account`

  Where `maxRevenue` is an alias. Create a port called `maxRevenue` in the output data object read operation that must be connected from the source data object read operation.

- Child objects can be related to parent objects using relations different from those specified in the data object read operation. For example, AccountPartner is related to Account with two relationship names, such as AccountPartnerTo and AccountPartnerFrom. However, in the data object read operation one relation, such as AccountPartnerTo is default. You can use the custom SOQL query to get the corresponding records for the other relation, such as AccountPartnerFrom.
Datatype Reference

This appendix includes the following topics:

- Datatype Reference Overview, 30
- Salesforce Datatypes and Transformation Datatypes, 30

Datatype Reference Overview

The Developer tool uses the following datatypes in PowerExchange for Salesforce mappings.

- **Salesforce native datatypes.** Salesforce native datatypes appear in the physical data object column properties.
- **Transformation datatypes.** Set of datatypes that appear in the transformations. They are internal datatypes based on ANSI SQL-92 generic datatypes, which the Data Integration Service uses to move data across platforms. Transformation datatypes appear in all transformations in a mapping.

When the Data Integration Service reads source data, it converts the native datatypes to the comparable transformation datatypes before transforming the data. When the Data Integration Service writes to a target, it converts the transformation datatypes to the comparable native datatypes.

Salesforce Datatypes and Transformation Datatypes

The following table lists the Salesforce datatypes that Data Integration Service supports and the corresponding transformation datatypes

<table>
<thead>
<tr>
<th>Salesforce Datatype</th>
<th>Range and Description</th>
<th>Transformation Datatype</th>
</tr>
</thead>
<tbody>
<tr>
<td>AnyType</td>
<td>Polymorphic data type that returns string, picklist, reference, boolean, currency, integer, double, percent, ID, date, datetime, URL, or email data.</td>
<td>String</td>
</tr>
<tr>
<td>Base64</td>
<td>Base64 encoded binary data</td>
<td>String</td>
</tr>
<tr>
<td>Boolean</td>
<td>Boolean (true/false) values.</td>
<td>Integer</td>
</tr>
<tr>
<td>Salesforce Datatype</td>
<td>Range and Description</td>
<td>Transformation Datatype</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>---------------------------------------------------------------------------------------</td>
<td>-------------------------</td>
</tr>
<tr>
<td>Byte</td>
<td>A set of bits.</td>
<td>String</td>
</tr>
<tr>
<td>Combox</td>
<td>Enumerated values.</td>
<td>String</td>
</tr>
<tr>
<td>Currency</td>
<td>Currency values.</td>
<td>Decimal</td>
</tr>
<tr>
<td>DataCategoryGroupReference</td>
<td>Types of category groups and unique category names.</td>
<td>String</td>
</tr>
<tr>
<td>Date</td>
<td>Date values.</td>
<td>Date/Time</td>
</tr>
<tr>
<td>DateTime</td>
<td>Date and time values.</td>
<td>Date/Time</td>
</tr>
<tr>
<td>Double</td>
<td>Double values.</td>
<td>Decimal</td>
</tr>
<tr>
<td>Email</td>
<td>Email addresses.</td>
<td>String</td>
</tr>
<tr>
<td>Encrypted String</td>
<td>Encrypted text fields contain any combination of letters, numbers, or symbols that are stored in encrypted form.</td>
<td>String</td>
</tr>
<tr>
<td>ID</td>
<td>Primary key field for a Salesforce object</td>
<td>String</td>
</tr>
<tr>
<td>Int</td>
<td>Fields of this type contain numbers with no fraction portion.</td>
<td>Integer</td>
</tr>
<tr>
<td>Master record</td>
<td>ID of the merged record.</td>
<td>String</td>
</tr>
<tr>
<td>Multipicklist</td>
<td>Multiple-selection picklists, which provide a set of enumerated values that you can select multiple values from.</td>
<td>String</td>
</tr>
<tr>
<td>Percent</td>
<td>Percentage values.</td>
<td>Decimal</td>
</tr>
<tr>
<td>Phone</td>
<td>Phone numbers</td>
<td>String</td>
</tr>
<tr>
<td>Picklist</td>
<td>Single-selection picklists, which provide a set of enumerated values that you can select one value from.</td>
<td>String</td>
</tr>
<tr>
<td>Reference</td>
<td>Cross-references to another Salesforce object.</td>
<td>String</td>
</tr>
<tr>
<td>String</td>
<td>Character strings.</td>
<td>String</td>
</tr>
<tr>
<td>Textarea</td>
<td>String that appears as a multiple-line text field.</td>
<td>String</td>
</tr>
<tr>
<td>Time</td>
<td>Time values.</td>
<td>Date/Time</td>
</tr>
<tr>
<td>URL</td>
<td>URL values.</td>
<td>String</td>
</tr>
</tbody>
</table>
INDEX

A
advanced properties 14

B
bulk API 28

capture deleted and archived records 26
capturing changed data 26
CDC 26
column properties 12
configure
time-period based CDC 28
configuring HTTP proxy options
  Developer tool 2
creating
  Salesforce connection 7
  Salesforce data object read operation 16
custom Salesforce objects 9

data object read operation
  creating 16
datatype reference overview 30

I
importing
  Salesforce data object 16

M
mapping output 17

O
overview
  Salesforce data object 9

P
PowerExchange for Salesforce
  overview 1
  process
    continuous CDC 27
properties
  Salesforce data object 10
  Salesforce data object read operation 11

R
related objects 10
rules and guidelines
  related objects 10
time-period based CDC 28
run-time processing
  overview 25

S
salesforce
  configure continuous CDC 27
  continuous CDC 27
  custom SOQL query 29
  prerequisites 2
  Salesforce
    mapping example 17
    mapping input 17
    mapping overview 17
  Salesforce connection
    creating 7
    overview 5
    properties 5
  Salesforce data object
    importing 16
  Salesforce data object read operation
    creating 16
    properties 11
  salesforce lookup
    condition 19
    creating 24
    overview 19
    properties 20
    rules and guidelines 23
  Salesforce lookup
    advanced properties 22
    general properties 20
    lookup properties 22
    ports properties 21
    source properties 11
    standard Salesforce objects 9

time-period based CDC 28
understanding related objects 10